
GENERAL SERVICES ADMINISTRATION
Federal Acquisition Service
Authorized Federal Supply Schedule Price List
On-line access to contract ordering information, terms 
and conditions, up-to-date pricing, and the option 
to create an electronic delivery order are available 
through GSA Advantage!, a menu-driven database 
system. The INTERNET address GSA Advantage! is 
GSAAdvantage.gov.

FSC Group 71, Part I, Office Furniture
FSC Class 7110
Contract Number:  GS-29F-0109G
Contract Period:    10/01/06 - 09/30/11
For more information on ordering from Federal 
Supply Schedules click on the FSS Schedules button 
at fss.gsa.gov.

WATSON FURNITURE GROUP
26246 Twelve Trees Lane NW
Poulsbo, WA 98370
Phone:	 (360) 394-1300
Fax:	 (360) 394-1322
Toll Free:	 (800) 426-1202
Website: www.watsondesking.com
Business Size: Small

Essential Furniture for Lean Organizations

NOTE: This PDF document includes interactive bookmarks, page numbers and tabs for easy click-through navigation.

CLICK HERE for more information on navigating within this PDF document.

P RO D U C T  P R I C E  L I S T   /   D E C E M B E R  2 0 1 0



www.watsonfurniture.com  Page 1 

 

WATSON FURNITURE GROUP

FSC Group 71, Part 1 Office Furniture
FSC Class 7110
GSA Contract – GS-29F-0109G
Contract Period:  10/01/2006 – 09/30/2011
Business Size:  Small

Watson Furniture Group
26246 Twelve Trees Lane NW
Poulsbo, WA 98370
Phone:  360-394-1300
Fax:       360-394-1322
Toll Free:  800-426-1202

ORDERING INFORMATION

WATSON DESKING

Watson Desking brand includes – Miro, M2, Fusion and ActiveWerks

1a.  SPECIAL ITEM NUMBERS (S.I.N.)  711-11 Tables and Accessories
711-2 Worksurface, Workstations, Computer Furniture

Accessories
711-3 Filing & Storage Cabinets, Shelves, Mobile 

Carts, Dollies, Racks & Accessories
711-95 Installation – Case-by-Case
711-95 Design and Layout - $55/hr

1b. LOWEST PRICED MODEL: 711-11 XFI3426 $224
711-2 DASN $1
711-3 SMP24 $127

2. MAXIMUM ORDER LIMITATION: $500,000

3. MINIMUM ORDER: $100

4. GEOGRAPHIC COVEREAGE: 48 Contiguous States, Washington DC and Port of   
Exportation for Alaska, Hawaii and Puerto Rico

5. POINT OF PRODUCTION: Poulsbo, Washington

6. DISCOUNT FROM LIST PRICE 58.1% Freight included for orders over    

                                                                                          

$6,285 GSA net.
60.7% To Western Washington, the metro areas of

Portland, Salem and Eugene, Oregon, freight
Included for orders over $6,285 GSA net.

63.3% For customers in Western Washington, the 
Areas of Portland, Salem, and Eugene, Oregon
requesting freight FOB Watson.
a. Customer Will-Calls Order
b. Customer Self-Contracts Freight

http://www.watsonfurniture.com/�
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7. QUANTITY DISCOUNTS:  $300,000 - $399.999 Additional 1% 
      $400,000 - $449,999 Additional 2% 
      $450,000 - $500,000 Additional 3% 
 
8. PROMPT PAYMENT TERMS:  5% 10 Days, 2% 20 Days, Net 30 (Terms available  

Based on Watson invoice date only) 
 
9. GOVERNMENT CREDIT CARDS: Accepted For All Purchase Thresholds 
 
10. FOREIGN ITEMS:   None 
 
 
11a. TIME OF DELIVERY:   45-60 Days ARO 
11b. EXPEDITED DELIVERY:  N/A 
 
11c. OVERNIGHT & 2-DAY DELIVERY N/A 
 
11d. URGENT REQUIREMENTS:  Inquire with Watson Factory at (800) 426-1202. 
 
12. F.O.B. POINT:    Poulsbo, Washington, FOB Destination for all points  
      within the contiguous United States, Washington DC  
      and Port of Exportation for Alaska, Hawaii, and Puerto 
      Rico on orders over $6285 GSA net. 
 
13a. ORDERING ADDRESS:   Watson Furniture Group 
      26246 Twelve Trees Lane NW 
      Poulsbo, WA  98370 
 
13b. ORDERING PROCEDURES:  All orders must be submitted in writing.  Watson does 
      not accept an order until the order is verified complete by 
      a Watson Project Manager, which will include price  
      information and anticipated arrival date.  The Order  
      Confirmation of the contract between the customer and 
      Watson Furniture Group. 
 
14. REMIT TO ADDRESS:   Watson Furniture Group 
      26246 Twelve Trees Lane NW 
      Poulsbo, WA  98370 
 
15. WARRANTY PROVISIONS:  Lifetime (contact Watson Factory for more details) 
 
16. EXPORT PACKAGING CHARGES: Contact Contractor for Export Packaging 
 
17. TERMS & CONDITIONS OF 
 GOVERNMENT PURCHASE CARD 
 ACCEPTANCE:    None 
 
18. TERMS & CONDITIONS OF RENTAL  
 MAINTENANCE AND REPAIR:  None 
 
19. TERMS & CONDITIONS OF  
 INSTALLATION:   All units are shipped KD (disassembled). 
      Contact Contractor for pricing and scheduling of 
      Installation. 

http://www.watsonfurniture.com/�


www.watsonfurniture.com  Page 3 

 

 
20. TERMS & CONDITIONS OF  
 REPAIR PARTS:   N/A – Contact Contractor 
 
21. LIST OF SERVICES:   N/A 
 
22. LIST OF PARTICIPATING  
 DEALERS:    Please contact Watson factory at (800) 426-1202. 
 
23. PREVENTATIVE MAINTANENCE: N/A 
 
24a. ENVIRONMENTAL ATTRIBUTES Yes.  Please contact Watson factory at (800) 426-1202. 
 
24b. YEAR 2000 COMPLIANT:  N/A 
 
25. DUNS NUMBER:   009479296 
 
26. CCR DATABASE REGISTRATION: Yes.  Cage Code 7N051 
      

           

http://www.watsonfurniture.com/�
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INTRODUCTION

Seven from Watson Desking:
Essential Furniture for Lean Organizations

Seven’s innovative design allows facility professionals to 

manage inventories of contoured surface shapes without 

regard to handedness. Seven’s worksurfaces are seamlessly 

finished on both sides; simply flip the surface and the left-hand 

becomes the right and vice-versa.

No more need for traditional rectangles that may be easy to 

manage, but do not respond to the needs of the user.

Seven’s desk shapes integrate with Watson Desking storage 

for cubicle infill applications. The restrained design and low 

profile foot blend with a variety of contemporary environments.

Along a spine wall or in open plan applications, Seven’s 

Dividing Screens provide light scale space division with two 

heights available. Seven’s Dividing Screens offer a single 

tool assembly, but once assembled, the screens may be 

repositioned along the utility beam without tools. 

Specify Seven’s vertical cable channel raceway to shroud 

cables along the leg.

Image Notes
Desk shapes this page are shown with ped bay. Tables 69 inches and  
longer include ped bay. Crank handle location is always on the shallow  
end (24 inch) of the desk.

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS
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HOW TO SPECIFY

Product Dimensions

Product Code

Product Options
Base, Smartgrain/Standard Finish, Edge, etc.

Finish Options
Surface, Edge and Base

Product Code Indicators
Boxes available to fill out a complete 
product code.

Index Tabs
Reference sections throughout 
the price list.

Upgrade Options and Notes
Reference important upgrades or notes that 
can affect your order.
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DESKS

Extended Corner 24
Extended Corner 30

Rectangle
Inset

Guest Conference

08
08
09
09
10
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DESKs

PRODUCT NOTES

Grain Direction runs the B length of the worksurface.

Extended Corner tables 69 inches and longer include 
pedestal bay.

Tables 57 inches, 63 inches, 69 inches, 75 inches,  
81 inches long are sized to mate with 15 inch  
wide towers.

Tables are unhanded, and can be assembled in 
a left-handed or right-handed configuration.

EDGE INDEX

17SURFACE INTERLOCK ASSEMBLY™

UTILITY BEAM / CABLE MANAGEMENT 19

DIVIDING SCREEN / MODESTY SHIELD 20

ADJUSTMENT OPTIONS 21

FINISHES 26

EXTENDED CORNER 24
Shown as Right Hand

24

24

A

B

 Product

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCA

SVDXCB

SVDXCB

SVDXCB

SVDXCB

SVDXCB

26-39
G

$

2305

2315

2315

2320

2320

2330

2330

2490

2490

2550

2330

2330

2490

2490

2550

22-33
U

$

1720

1730

1730

1735

1735

1745

1745

1905

1905

1965

1745

1745

1905

1905

1965

$

1505

1515

1515

1520

1520

1530

1530

1690

1690

1750

1530

1530

1690

1690

1750

Fixed
29.5
D

Front Crank
26-39

E
22-33

J

Notch

 Edge

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

 Finishes

Edge


 
 



 
 




 
 



Base


 
 



 
 




 
 



Surface


 
 



 
 




 
 



Smart-
grain

(+ $100)

Yes = A
No = S

 Smart-
 grain


















Premium Laminates
Smartgrain laminates feature a unique finish with 
gloss and texture similar to real-wood laminates. 
See page 26 for details.

90 Edge
3mm ABS edge

EXTENDED CORNER 30
Shown as Right Hand

30

24

A

B

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

54

57

60

63

66

69

72

75

78

81

69

72

75

78

81


 
 



 
 




 
 



Side A

48 = 48"
51 = 51"
54 = 54"
57 = 57"
60 = 60"

Side B
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RECTANGLE

A

B

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

INSET
Shown as Right Hand

A

B

PRODUCT NOTES

Grain Direction runs the B length of the worksurface.

Tables are unhanded, and can be assembled in 
a left-handed or right-handed configuration.

INDEX

17SURFACE INTERLOCK ASSEMBLY™

UTILITY BEAM / CABLE MANAGEMENT 19

DIVIDING SCREEN / MODESTY SHIELD 20

ADJUSTMENT OPTIONS 21

FINISHES 26

DESKs  Product

A / B

SVDXIN3024

SVDXIN3030

SVDXIN3036

SVDXIN3042

SVDXIN3048

SVDXIN3054

SVDXIN3060

SVDXIN3066

SVDXIN3072

SVDXRE2424

SVDXRE2430

SVDXRE2436

SVDXRE2442

SVDXRE2448

SVDXRE2454

SVDXRE2460

SVDXRE2466

SVDXRE2472

30    24

30    30

30    36

30    42

30    48

30    54

30    60

30    66

30    72

24    24

24    30

24    36

24    42

24    48

24    54

24    60

24    66

24    72

26-39
G

$

1300

1345

1350

1395

1405

1485

1545

1550

1560

1270

1310

1320

1365

1375

1455

1460

1520

1530

22-33
U

$

890

935

940

985

995

1075

1135

1140

1150

860

900

910

955

965

1045

1050

1110

1120

$

745

790

795

840

850

930

990

995

1005

715

755

765

810

820

900

905

965

975

Fixed
29.5
D

Front Crank
26-39

E
22-33

J

Notch

 Finishes

Edge


 
 


 
 




 
 



 
 


Base


 
 


 
 




 
 



 
 


Surface


 
 



 
 



 
 



 
 


 Edge

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Z

Smart-
grain

(+ $100)

Yes = A
No = S

 Smart-
 grain





















EDGE 

Premium Laminates
Smartgrain laminates feature a unique finish with 
gloss and texture similar to real-wood laminates. 
See page 26 for details.

90 Edge
3mm ABS edge
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GUEST CONFERENCE
Shown as Right Hand

30

24

A

B

DESKS

PRODUCT NOTES

Side B of guest conference tables do not 
accept dividing screens.

Side B of guest conference tables accepts 
modesty shields at a recessed depth to 
accommodate guest seating with leg clearance.

Tables are unhanded, and can be assembled in 
a left-handed or right-handed configuration.

 Product

A / B

SVDXGC6054

SVDXGC6060

SVDXGC6072

60    54

60    60

60    72

26-39
G

$

2315

2320

2340

22-33
U

$

1730

1735

1755

$

1515

1520

1540

Fixed
29.5
D

Front Crank
26-39

E
22-33

J

Notch

 Finishes

Edge


 

 



Base


 

 



Surface


 

 



 Edge

Z

Z

Z

Z

Smart-
grain

(+ $100)

Yes = A
No = S

 Smart-
 grain







INDEX

17SURFACE INTERLOCK ASSEMBLY™

UTILITY BEAM / CABLE MANAGEMENT 19

DIVIDING SCREEN / MODESTY SHIELD 20

ADJUSTMENT OPTIONS 21

FINISHES 26

 

A

B

30

24
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ACCESSORIES

Dividing Screen
Modesty Shield

Vertical Cable Channel
Cable Harness 

12
13
14
14

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS



12    WATSON DESKING

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

ACCESSORIES

Price

$

 H / W

19   24

19   30

19   36

19   42

19   48

19   51

19   54

19   57

19   60

19   63

19   66

19   69

19   72

19   75

19   78

19   81

24   24

24   30

24   36

24   42

24   48

24   51

24   54

SVDS1924

SVDS1930

SVDS1936

SVDS1942

SVDS1948

SVDS1951

SVDS1954

SVDS1957

SVDS1960

SVDS1963

SVDS1966

SVDS1969

SVDS1972

SVDS1975

SVDS1978

SVDS1981

SVDS2424

SVDS2430

SVDS2436

SVDS2442

SVDS2448

SVDS2451

SVDS2454

Fabric

 Product  Finishes



 







 









 




PRODUCT NOTES

DIVIDING SCREEN *

Powder



 







 









 




INDEX

DIVIDING SCREEN 22

FINISHES 28

*Dividing Screen is not compatible with Power 
Adjustable Tables. Contact Customer Service for alterna-
tive privacy options.

Dividing screen is mounted to each bracket with two sur-
face interlocks with zinc screws.

Panels are made of 3/8 inch thick 100% fiber board and 
textile covered.

Powdercoated utility beam is slotted to receive screen 
bracket.

Dividing screen is available in two heights, 24 inches and 
19 inches.

For desk-mounted privacy options, 
contact Watson Customer Service 
at 800.426.1202.
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$

ACCESSORIES

PRODUCT NOTES INDEX

MODESTY SHIELD 20

FINISHES 26

Price

 H / W

13   18 

13   24

13   30

13   36

13   42

13   45

13   48

13   51

13   54

13   57

13   60

13   63

13   66

13   69

13   72

13   75

SVMS1318 

SVMS1324

SVMS1330

SVMS1336

SVMS1342

SVMS1345

SVMS1348

SVMS1351 

SVMS1354

SVMS1357

SVMS1360

SVMS1363

SVMS1366

SVMS1369

SVMS1372

SVMS1375

Powder

 Product  Finishes



 







 






MODESTY SHIELD *

* Modesty Shield is not compatible with Power 
Adjustable Tables. Contact Customer Service for alterna-
tive privacy options.

Modesty shield is powdercoated steel with gray fabric 
liner (user facing). Fabric dampens sound.

Modesty shield mounts to utility beam with brackets. 
Width is 6 inches less than nominal dimension. 

Order Modesty shields 6 inches shorter than the ordered 
worksurface.

For desk-mounted privacy options, 
contact Watson Customer Service 
at 800.426.1202.
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ACCESSORIES

Price

$

75

80

85

30

 H / W

17    -

21    -

24    -

-

SVCCH17

SVCCH21

SVCCH24

SVHAR5

Powder

 Product  Finishes



 

-

VERTICAL CABLE CHANNEL

PRODUCT NOTES INDEX

DIVIDING SCREEN 20

FINISHES 26

Vertical cable channel uses a magnetic powdercoated 
steel formed cover to conceal and guide cables along leg.

CABLE HARNESS 
Set of 5
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PRODUCT INFORMATION

Universal Handedness
Surface Interlock Assembly™

Solid State Construction / Maximum Clearance
Utility Beam / Cable Management
Dividing Screen / Modesty Shield 

Adjustment Options
Environmentally Preferred Materials

MATERIALS & SPECIFICATIONS

TERMS & CONDITIONS

FINISHES

16
17
18
19
20
21
22

23

24

26
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Assembled as Left Handed

Assembled as Right Handed

UNIVERSAL HANDEDNESS

DESIGN INTENT:

Handed worksurfaces solve real user needs with 
natural contours that create a comfortable body pocket 
with enhanced visual and physical reach, particularly 
useful in today’s multi-device digital world. Seven’s 
worksurfaces are seamlessly finished on both sides; 
simply flip the surface and the left-hand becomes the 
right and vice-versa.

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS
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Leg Assembly

Surface Interlock Assembly™

SURFACE INTERLOCK ASSEMBLY™

DESIGN INTENT:

Our patent pending Surface Interlock Assembly™ provides 
a mechanical connection between the worksurface and the 
base. Right handed or left handed, your surface will bear no 
markings from its previous assembly. 

The compressive force of this interlock provides unequaled 
strength to the table, while its pleasing appearance reflects 
Seven’s smart design. 

And of course – Seven exceeds BIFMA requirements.
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Easy Glide Leveling

SOLID STATE CONSTRUCTION / MAXIMUM CLEARANCE

DESIGN INTENT:

Seven’s base design contains no decorative plastic 
parts and pieces to break or fall off. That means fewer 
headaches for inventory management and fewer problems 
for installers. 

Seven was designed with the user in mind. The 
compressive strength of the Surface Interlock Assembly™ 
is so robust the need for a knee-height cross rail was 
eliminated. User leg clearance is assured and storage 
units dock easily without interference. Seven’s unique foot 
is the lowest profile in the industry and allows external 
side access to glide leveling.
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UTILITY BEAM  / cable MANAGEMENT

DESIGN INTENT:

Seven’s Utility Beam provides a simple single tool support 
for accessories such as cable harnesses and dividing 
screens, while preventing deflection of the surface and 
providing remarkable lateral stability to the workstation.

Utility Beam: Designed with multiple slots 
to allow flexible spacing of dividing screens.

Vertical Cable Channel: Available in three 
heights (17", 21", 24"), the  channel uses a 
magnetic powdercoated steel formed cover to 
conceal and guide cable along the leg.

Cable Harness: Flexible looped 
cable management.
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INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

DIVIDING SCREEN / MODESTY SHIELD

Please refer to Fusion desk-mounted privacy panels and 
M2 modesty shields for SEVEN screening options.

For assistance, contact Watson Customer Service at 
800.426.1202.
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DESIGN INTENT:

Seven tables are available in a 22"-33" (BIFMA compliant) 
height range, or a 26"-39" alternative range that allows 
for a counter style working height. Adjustment ranges 
can be specified as facility-adjustable or user-adjustable. 
Seven tables are also available at a standard fixed height 
of 29.5".

Fixed Height: Fixed height tables are set at a standard 
height of 29.5".

Facility-adjustable: Notch adjustable bases provide an 
11" or 13" range of height adjustability in 1" increments 
utilizing a dual-notch telescoping mechanism.

User-adjustable: Front crank lift mechanisms provide an 
11" or 13" range of height adjustability with 150 lbs of 
lifting capacity atop the work surface.

33"

22"

39"

26"

ADJUSTMENT OPTIONS
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U.S. EPA
COMPREHENSIVE PROCUREMENT GUIDELINE

LEED CONTRIBUTIONS

GREENWORKS BUSINESS
KITSAP COUNTY, WA.

WASHINGTON STATE

GOVERNOR’S AWARD
SUSTAINABLE PRACTICES / POLLUTION PREVENTION AWB ENVIRONMENTAL 

EXCELLENCE AWARD

C  E  R  T  I  F  I  E  D    L  A  M  I  N  A  T  E  S

Designed and manufactured almost entirely of 
environmentally preferred materials, Seven contains a 
high level of recycled content and uses some of the 
industry’s lowest-impact manufacturing processes. 
Seven products can also contribute to LEED certification 
credits and help customers meet their own corporate 
environmental standards. 

For more information about Watson’s environmental 
stewardship, or to read about Watson’s award winning 
green program, please visit www.watsondesking.com/
stewardship.

Textiles
100% recycled content

Bases
Cold-rolled steel, 
89.7% recycled, 
100% recyclable

Laminate
GreenGuard Indoor Air 
Quality Certification with 
20% recycled content

Worksurface Edge
These are synthetic edges made of 
an extruded 3mm thick ABS, with a 
durometer chosen for its flexibility,
durability and self healing properties. 

Adhesives
Low-VOC water-based 
adhesives

Wood Substrate
92% recycled industrial 
by-product

Tackable Substrate
Recycled fiber board

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

ENVIRONMENTALLY PREFERRED MATERIALS
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DESK COMPONENTS

Seven Legs

Top support brackets are 12-gauge cold rolled 
sheet steel. Powder coated. Crank handles are 
die cast zinc alloy and powder coated. Vertical 
tube assembly  2" x 2" and 1.5" x 1.5" (.083") thick 
steel welded to top support and foot. Glides are 
screwed into metal inserts that are welded into foot.   
Adjustment mechanism utilizes beveled gear lift 
assemblies in each leg connected by extruded 
aluminum shafts. 12-gauge formed utility beam 
interconnects all legs. Powder coated.

Worksurfaces

Materials: 
Worksurfaces that are edged with a synthetic 
material are 1.25" thick and are composed of 
horizontal grades of laminate both sides (Power 
Adjustable Tables are only laminated on one side) and 
are bonded to a 1.125" industrial grade particleboard 
core. Watson particleboard is recovered from 
Douglas Fir. The longer strands of the Douglas Fir 
provide superior deflection characteristics.

Worksurface dimensions are net sized by .5" overall 
to allow for vertical movement without interference of 
plugs, wires, brackets and panels.

Metal-to-Metal Connections: 
Desk surfaces are fastened to the legs with steel 
machine screws threaded into metal inserts on leg 
assembly. Cast zinc bezel provides compression 
surface.

Built-in Cable Management: 
Horizontal: Hook and loop anchor points are provided  
as an option along length of utility beam. 
Vertical: 16-gauge formed sheet metal vertical 
raceways are magnetically attached to the 2" x 2" 
vertical leg.

Edge
These are synthetic edges made of an extruded 3mm 
thick PVC, with a durometer chosen for its flexibility,
durability and self healing properties. 

ACCESSORIES

Dividing Screens & Modesty Shields

For desk-mounted privacy options, contact Watson 
Customer Service at 800.426.1202.

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

materials & specifications
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Terms of Sale

This Price List and these Terms of Sale supercede 
all previous price lists and terms. These prices and 
terms are subject to change without notice.

Prices

List prices include freight costs as specified below.  
No other charges are included in Watson’s list prices 
unless otherwise specified in writing.

Terms of Payment

Terms of payment will be established based on the 
credit rating and credit information provided by and 
for specific customers. Orders are invoiced at time 
of shipment.  Standard payment terms are 50/50; 
50% due at time of order and 50% due at time of 
shipment. Approved credit levels may be extended 
to net thirty (30).

Past due accounts will be charged the lesser of 1.5% 
per month or the highest rate permitted by law plus 
all collection costs, including reasonable attorney’s 
fees and expenses.

Taxes

The Customer shall pay all sales, use, excise and 
other taxes applicable to the sale. Resale and/or 
exemption certificates must be forwarded to Watson 
at the time of order.

Order Acceptance

All orders must be submitted in writing. Watson 
does not accept an order until the order is verified 
complete by a Watson Project Manager, which will 
include price information and anticipated arrival date.  
The Order Confirmation is the final expression of the 
contract between the Customer and Watson. 

Order Changes and Cancellations

Purchase orders may not be changed or cancelled, 
in whole or in part, without prior written consent 
of Watson. Changes may effect delivery dates.  
Expenses incurred because of changes will be 
charged to Customer. In the event of cancellations, 
Customer will be liable for reasonable cancellation 
charges established by Watson. Orders for 
customized products, custom finishes and 
Customer’s Own Material (COM) items, hereinafter 
defined, may not be cancelled. 

Returns

The return of Products without a written authorization 
by Watson shall not be accepted. If Watson agrees 
to repurchase the product pursuant to a valid 
authorization, the Customer must return the Product 
freight prepaid to Watson.  The returned product 
shall be subject to a 25% of list restocking charge. 
All returned Products must be unused and in original 
condition. 

Watson will not accept returns on orders that include 
COM materials.

Landed Freight Program

Order Minimums
Order minimums have been determined to help us 
accurately compensate for our freight expenses 
on low-volume orders. Minimum order and freight 
charge rates for all territories* have been specified 
below by zone.

* Overseas and non-contiguous US shipments made 
to a prearranged departure port in any zone, will 
adhere to the defined order minimum and freight 
charges in that zone; carton packing charges may 
also apply to overseas shipments.

ZONE 1 (Local)
Seattle, Bellevue, Tacoma, Kitsap County, and the 
surrounding Puget Sound area 

·  For all orders less than $10,000 list, a freight 
charge of 5% list will be applied; fuel surcharges 
do not apply to these orders. 

ZONE 2
WA, OR, and CA

·  For all orders less than $15,000 list, a freight 
charge of 5% list will be applied; fuel surcharges 
do not apply to these orders.  

ZONE 3  
Contiguous US and Canada outside of WA, OR, 
and CA

·     For all orders less than $15,000 list, a freight charge 
of 10% list will be applied; fuel surcharges do not 
apply to these orders.  

Variable Fuel Surcharge
A Variable Fuel Surcharge will be applied to all orders 
over the established minimum order in each freight 
zone. The variable fuel surcharge (currently 3.6% of 
net) reflects fuel surcharge costs that our carriers 
charge, and will be applied to the order as follows: 
net price total of products multiplied by the variable 
fuel surcharge. Updated monthly, the Variable Fuel 
Surcharge rate is subject to change and should be 
confirmed at the time of quote. 

To view the Variable Fuel Surcharge and zone map 
online, please visit www.watsondesking.com/terms.

Shipping Program

Watson Furniture Group employs an environmentally 
friendly shipping program that reduces costs and 
helps ensure furniture is delivered in the same 
condition as it left the factory.  This careful handling 
may occasionally lengthen shipping times on 
LTL shipments.

Blanket wrap
This environmentally preferred process eliminates 
waste and reduces installation time associated with 
package removal and disposal.

Air-ride
Watson utilizes carriers whose trailers are equipped 
with air-ride suspension to minimize vibration and 
avoid damage in transit.
No cross docking
Once loaded on the truck, product will not be 
consolidated, moved, or off-loaded until the point of 
delivery.

At Watson's discretion and if it is determined in 
the best interest of customers, alternative shipping 
methods may be used.  Special requests including 
special shipping methods, delivery outside normal 
hours (8 a.m. to 5 p.m. Monday through Friday), 
inside delivery, notification, etc. shall be subject to an 
additional charge to the customer. 

Claims 

Risk of loss passes to Customer upon Watson’s 
delivery of the product to the carrier. Product 
shortages and damage must be noted on delivery 
receipts at the time of receipt by the Customer or 
Customer’s agent. If the carrier damaged the Product 
while in transit, the Customer has sole obligation of 
seeking any recourse against the appropriate carrier.  
Claims against Watson for shortages and errors 
must be made within seven (7) days of the date of 
delivery.

Title

Title to the Product shall remain with Watson until the 
Product is fully paid for.

Packaging

Worksurfaces and storage components are sent 
blanket wrapped.  Frames are sent in cartons. 
The Customer may specify cartoning. To specify 
cartoning for all items add 5% of total list price

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

WATSON TERMS & CONDITIONS
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Storage

Watson may transfer Product to storage at the 
Customer’s risk and expense if the Customer is 
unable to take delivery of product as scheduled.  
Upon such transfer to storage, the Customer 
assumes risk of loss. Watson will invoice the 
Customer on a monthly basis for storage fees and 
the Customer will make payments in accordance with 
Watson’s standard payment terms. 

Loss, Damage or Delay

Watson shall not be liable for any loss, damage or 
delay resulting from forces beyond its reasonable 
control including fire, flood, strike or other labor 
difficulty, act of God, inability to obtain necessary 
labor, materials, or manufacturing facilities from 
usual sources, failure of suppliers to meet their 
contractual obligations or due to any cause beyond 
its reasonable control.

In the event of any such delay, delivery will be
postponed by such length of time as may be 
reasonably necessary to compensate for the delay. 

Customer’s Own Material (COM)

Customers may request fabrics, surface materials, 
and powdercoats that are not standard to Watson's 
finish offering according to the guidelines below.

Watson Customer Service will apprise customers of 
any possible impact on lead times resulting from the 
use of off-card materials and finishes.

Watson shall not be responsible for the appearance 
or performance of any COM material and customer 
shall hold Watson harmless for any damages or 
losses arising out of, or related to, the use of the 
COM on the Product. 

PRODUCT REPAIR OR REPLACEMENT IS THE 
CUSTOMER'S EXCLUSIVE REMEDY FOR ANY 
AND ALL PRODUCT DEFECTS.

COM orders cannot be cancelled and Watson will not 
accept product returns.

Seven

Fabric
·	 All COM requests for special fabric must be 
     tested and approved by Watson Furniture Group.
·	 A minimum sample of 3 yards must be submitted   
     to Watson for testing.
·	 Watson will notify customer of test results within
     5 business days and provide written approval and
     a COM request form.
·	 Upon approval, customer must provide produc-
     tion quantities of the approved fabric at least five
     days before production begins.
·	 No price adjustments will be made for customer-
     supplied fabric.

Laminates
·	 Watson must approve all COM requests for 
     laminates not listed on finish card.
·	 Non-specialty laminates from WilsonArt that are
   not on our finish card will be available subject 
   to a $500 list upcharge for recycling excess 
     materials.
·	 For requests concerning all other vendors and all
  specialty laminates, please contact Customer
   Service, which will determine manufacturability,
     schedule, and pricing.
·	 Evaluation of requests will take no longer than
     three business days.
·	 Watson will contact laminate vendors directly to
     determine availability and lead times.
·	 Upon approval and order acknowledgement,
      Watson will purchase COM laminates and arrange
     delivery to facilitate the production schedule.  

Powder
·	 Customer must provide powder sample for 
      testing.
·	 Upon approval, customer must provide produc-
   tion quantity powder three days in advance of
     scheduled beginning of production.
·	 No price adjustments will be made for customer
     supplied powder.

Frames

Approval of COM orders for Frames panels will be 
subject to an additional two week lead time.

Warranty

Watson warrants to the original Customer that the 
Products it manufactures are free of defects in 
craftsmanship and materials found during normal  
single shift (40 hour work week) usage of the 
products during the warranty period. Watson shall, 
upon prompt written notice, repair or replace, at 
its option and costs, the affected part or parts. 
All separate component parts not manufactured 
by Watson (keyboard mechanisms, power and 
data devices, etc.) shall be covered by the original 
manufacturer’s warranty.

This warranty does not apply to:
·	 Damage caused by a carrier.
·	 Normal wear and tear.
·	 Defects caused by improper installation.
·	 COM or other third party materials applied 
	 to the products.
·	 Products subjected to improper use and 
	 conditions.
·	 Damage resulting from misuse, negligence, 
	 accident or alterations.

Warranty Period

Five Years: Motors and other electrical components.
Lifetime: All other components.

EXCEPT AS STATED ABOVE, WATSON MAKES 
NO EXPRESS OR IMPLIED WARRANTIES AS TO 
ANY PRODUCT AND IN PARTICULAR MAKES NO 
WARRANTY OF FITNESS FOR ANY PARTICULAR 
PRODUCT EXCEPT FOR USE AS STANDARD 
OFFICE FURNITURE.  PRODUCT REPAIR OR 
REPLACEMENT IS THE CUSTOMER’S EXCLUSIVE 
REMEDY FOR ANY AND ALL PRODUCT DEFECTS.  

The remedies provided above are the Customer’s 
sole remedies for any failure of Watson to comply 
with its obligations regarding the workmanship of its 
products.

APRIL 2010

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

WATSON TERMS & CONDITIONS (continued)
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ANCHORAGE PATTERN
Amber
Angora
Asteroid
Coffee Bean
Cumin
Deep Water
Fossil
Goldenrod
Goose
Graphite
Green Olive
Henna
Midnight
Mulberry
Onyx
Quarry Blue
Red Delicious
Slate
Straw
Willow

DRIFT PATTERN
Alabaster
Chamois
Dusty Miller
Graphite
Mocha
Pebble
Slate
Sprout
Storm

SPRITE PATTERN
Butter
Harvest
Khaki
Kiwi
Linen
Powder
Sherbet
Sky
Snow

9B
9A
6D
9C
9U
9D
6X
9N
9E
9R
9O
6H
9M
9L
6Z
6Q
9I
6T
9S
9W

ØR
1H
ØD
ØI
3K
9P
4T  
7U
3J

4U
2V
7K
4K
2I
4D
4B
7Y
2W

FABRICS

Black
Charcoal
Mica
Satin Gray
Slate
White Aluminum
White Linen

BK
CH
M2
GY
SG
WA
WL

POWDERCOAT

Visit www.watsondesking.com/finishes for finish color representations or to order sample chips.

Amber Cherry*
Asian Night*
Asian Sand*
Blond Echo*
Colombian Walnut*
Mambo
Madagascar*
Monticello Maple*
Rio
Studio Teak*
Williamsburg Cherry*
Xanadu*

*Also available as a Standard Laminate, 
non-textured (see list on page 29).

SMARTGRAIN LAMINATES (textured)

JC
A1
A2
B8
C5
MO
DA
QI
RI
TX

W1
X1

SMARTGRAIN LAMINATES

Smartgrain laminates feature the polish and lux of a 
real wood veneer, with a subtle, narrow grain structure 
and higher gloss level. This gloss level (Glossometer 
reading of 38 compared to readings of 100 for High 
Gloss laminates and 10 for Matte laminates) provides 
a dramatic appearance but specifiers should be aware 
of the potential for increased fingerprinting.

Black
Charcoal
Jute
Satin Gray
Slate
White Linen

BK
CH
JT
GY
SG
WL

90 EDGES (3mm ABS)

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

FINISHES



 27 WATSON DESKING             

Alabaster
Almond Leather
Amazon
Amber Cherry * 
Antique Brush
Antique Roca
Antique White
Asian Night *
Asian Sand *
Asian Sun
Atlantis
Bannister Oak
Beige
Beige Nebula
Beige Pampas
Beigewood
Beryl Brush
Biltmore Cherry
Black
Blackstar Granite
Blond Echo *
Brazilwood
Brittany Blue
Bronze Legacy
Brune Slate
Burnished Chestnut
Burnished Ember
Café Crème
Caldera Beige
Canyon Zephyr
Carbon Evolve
Carbon Mesh
Castle Oak
Cloud
Cloud Nebula
Cloud Zephyr
Colombian Walnut *
Copper Evolve
Copper Mesh
Coral Roca
Crisp Zephyr
Curry Tigris
Dakota Ridge
Desert Zephyr
Designer White
Dove Grey
English Oak
Evening Tigris
Fashion Grey
Featherstone
Figured Mahogany
Flame Soapstone
Fleece
Fonthill Pear
Fresco
Frosty White **
Fusion Maple
Galvan

AB
A4
AZ
AC
AN
KQ
WQ
JN
JS
UI
TI

OB
BE
BN
EI
BI
YB
IB
BK
BJ
EH
ZW
BR
BZ
BS
BC
UE
EM
C6
ZN
GV
EJ
OQ
LD
CN
ZL
LQ
VR
EX
KR
ZQ
CT
DR
DZ
DH
DG
EO
ET
FQ
FH
QF
LN
F1
FP
F2
FJ
FM
VH

STANDARD LAMINATES

IQ
OJ
G5
GN
RY
G4
GT
QT
GG
EG
YN
GP
H3
HZ
HG
HE
H1
HN
HU
IN
IL

KA
KM
KB
LB
LU
LJ
LR
LT
LZ
LO
ZD
OM
UH
DD
DL
DJ
DN
DQ
XK
IX

DU
EZ

MW
OH
MR
MJ
MM
OZ
YD
YU
MQ
YA
YL
YO
YI
AO
NL

Gilded Marquetry 
Golden Oak
Granite
Graphite Nebula
Green Legacy
Green Soapstone
Green Tigris
Grey
Grey Glace
Grey Mesh
Grey Nebula
Grey Pampas
Harvest Maple
Haze
Heather Legacy
Hollyberry
Hunter Green
Hunter Nebula
Huntington Maple
Indigo
Iron Legacy
Karratha Brush
Kensington Maple
Khaki Brown
Lapis Blue
Larkspur
Light Beige
Limber Maple
Lithium Evolve
Loden Zephyr
Lodestone
Madagascar *
Manitoba Maple
Maroochy Brush
Mission Adobe
Mission Glaze
Mission Sage
Mission Sand
Mission Shadow
Mission Smoke
Mission Stone
Mission Stucco
Misted Zephyr
Montana Walnut
Monterey Haze
Monterey Storm
Monterey Sun
Monticello Maple *
Morro Zephyr
Mystique Dawn
Mystique Dusk
Mystique Marine
Mystique Marsh
Mystique Moonlight
Mystique Mount
Mystique Night
Natural Almond
Natural Legacy

NN
NJ
KX
NT
LY
N1
UJ

NW
NE
VJ
NR
OR
OS
OL
OX
AP
OE
PJ
PR
PE
PB
EP
PL
PT
P4
UY
R1
RV
RU
L3
ST
D1
L4
SV

DW
ZA
M3
EE

M4
S3
SG
SO
ZI
EK
JO
DT
XE
TH
TQ
QL
KE
TV
KU
TE

TW
IZ
VX
KV

Natural Nebula
Natural Pear
Natural Roca
Natural Tigris
Navy Legacy
Nepal Teak
Neutral Glace
New Age Oak
Nickel Evolve
Nirvana 
North Sea
Ochre Roletta
Oiled Soapstone
Olive Legacy
Oxide
Pampas
Pearl Soapstone
Pebble
Pepperdust
Pewter
Pewter Brush
Pewter Mesh
Platinum
Port
Puma
Putty
Radium Evolve
River Cherry
Rustic Slate
Sable Soapstone
Saffron Tigris
Sand
Sanibel Maple
Savoy Cherry
Shadow
Shadow Zephyr
Shale Moonstone
Sheer Mesh
Sierra Marble
Silicon Evolve
Slate
Solar Oak
Spiced Zephyr
Steel Mesh
Stratos
Studio Teak *
Sunstone
Tan Echo
Tan Soapstone
Tawny Legacy
Terra Roca
Titanium Evolve
Tumbled Roca
Tungsten Evolve
Tuscan Walnut 
Twilight Zephyr
Verdi Oxide
Villa Roca

YW
JB
JI
JR

XW
JU
JQ
JW
W4
XL
EN
JH
EU
WG
WC
JL

MA
WI
WB
WP
WO
DØ

Wallaby
Western Bronze
Western Hills
Western Iron
Western Storm
Western Suede
Western Tan
Western White
White
White Leather
White Nebula
White Sand
White Suede
White Tigris
Wild Cherry
Williamsburg Cherry *
Windsor Mahogany
Windswept
Windswept Bronze
Windswept Pewter
Woolamai Brush
Xanadu *

* Also available in Smartgrain finishes

** Case and edge colors match, but   
    are called White Linen (WL)

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS

FINISHES (cont)



28    WATSON DESKING

For Customer Service Inquiries, please contact:

800.426.1202

360.394.1322 fax

www.watsondesking.com

INTRODUCTION ACCESSORIES PRODUCT INFORMATIONDESKS
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PRICE GUIDE PDF 101 
These PDF files have been created to be as user-friendly and easy to navigate and annotate as possible. All 


Price Guide PDFs include the following capabilities in Adobe Reader or Acrobat: 


 


 


INTERACTIVE PAGE NUMBERS & TABS 
 


All page number references and tabs have been linked to their corresponding page numbers. Any time 


your mouse pointer turns into a       pointing hand when hovering over an item that item is interactive and 


can be clicked to help navigate through the PDF. 
 


 


SEARCHING A PDF 
 


Use either the Search window (Edit > Search) or the “Find” field on the toolbar to search page content, 


including key words, part numbers, bookmarks, etc. 


 


 


BOOKMARKS 
 


The electronic pricer includes bookmarks that act as a table of contents for the PDF. They are used to 


mark all pertinent sections or items and you can jump to the referenced areas with a single click.  
 


 
Using Bookmarks 
 


         On the left-hand side of the screen open the  “bookmark” menu  


 Click on any link listed and be taken to the appropriate page. 


 


 


ELECTRONIC NOTATIONS 
 


Use commenting and markup tools to add comments (View > Toolbars > Comment & Markup). You 


can type a text message using the Sticky Note tool. Just go to Comments in the top menu and choose 


“Add Sticky Note.”  Numerous other text editing tools are available, and notes can be exported or 


imported as well. 


 


 
Select a commenting or markup tool 
 


 Do one of the following:  


 Select a tool from the Comment & Markup toolbar. 







(To add the Comment & Markeup toolbar: Tools > Comment & Markup > Show Comment & 


Markup Toolbar.) 


 Choose Tools > Comment & Markup > [tool]. 


Note: After you make an initial comment, the tool changes back to the Select tool so that you can move, 


resize, or edit your comment. (The Pencil, Highlight Text, and Line tools stay selected.) 


 
To import comments to a PDF after the document has been revised, use the Migrate Comments 


feature. This feature attempts to place comments in the correct location by searching specific word 


groupings and structural elements in the revised PDF. Text comments that reference particular words, 


such as highlights, cross-outs, and insertion carets, appear within the word grouping where they were 


originally placed. Drawing markups and sticky notes appear in the same structural location as they did in 


the original document. Circle, polygon, rectangle, and stamp comments always appear on the same page 


as the original document 


 


 
Importing comments to a revised PDF 
 


 In the original PDF, open the “Comments” menu in the lower left hand corner of the screen.  


 In the top left corner of that menu is another drop down menu (next to a “gear” image), 


click there and select “Export Selected Comments” 


 Save the file to your computer. 


 In the new PDF, follow step 1 and 2 above, instead of “Export Selected Comments” select 


“Import Comments” and locate the file just saved to your computer. 


 







